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Introduction

This manual contains detailed instructions and notes on the operation and use of this machine. For your safety and 

benefit, read this manual carefully before using the machine. Keep this manual in a handy place for quick reference.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be liable for direct, 

indirect, special, incidental, or consequential damages as a result of handling or operating the machine.

Do not copy or print any item for which reproduction is prohibited by law.

Copying or printing the following items is generally prohibited by local law:

bank notes, revenue stamps, bonds, stock certificates, bank drafts, checks, passports, driver's licenses.

The preceding list is meant as a guide only and is not inclusive. We assume no responsibility for its completeness or 

accuracy. If you have any questions concerning the legality of copying or printing certain items, consult with your 

legal advisor.

Notes:

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.

Depending on which country you are in, your machine may include certain options as standard. For details, please 

contact your local dealer.

Caution:

Use of controls or adjustments or performance of procedures other than those specified in this manual might result

in hazardous radiation exposure.



Manuals for This Machine
Read this manual carefully before you use this machine.

Refer to the manuals that are relevant to what you want to do with the machine.

• Media differ according to manual.

• The printed and electronic versions of a manual have the same contents.

• Adobe Acrobat Reader/Adobe Reader must be installed in order to view the manuals as PDF files.

• A Web browser must be installed in order to view the html manuals.

About This Machine

Before using the machine, be sure to read the section of this manual entitled Safety Information.

This manual provides an introduction to the functions of the machine. It also explains the control panel,
preparation procedures for using the machine, how to enter text, and how to install the CD-ROMs
provided.

Troubleshooting

Provides a guide to solving common problems, and explains how to replace paper, toner, staples,
and other consumables.

Copy/ Document Server Reference

Explains Copier and Document Server functions and operations. Also refer to this manual for
explanations on how to place originals.

Facsimile Reference

Explains Facsimile functions and operations.

Printer Reference

Explains Printer functions and operations.

Scanner Reference

Explains Scanner functions and operations.

Network Guide

Explains how to configure and operate the machine in a network environment, and use the software
provided.

General Settings Guide

Explains User Tools settings, and Address Book procedures such as registering fax numbers, e-mail
addresses, and user codes. Also refer to this manual for explanations on how to connect the machine.
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Security Reference

This manual is for administrators of the machine. It explains security functions that you can use to
prevent unauthorized use of the machine, data tampering, or information leakage. For enhanced
security, we recommend that you first make the following settings:

• Install the Device Certificate.

• Enable SSL (Secure Sockets Layer) Encryption.

• Change the user name and password of the administrator using Web Image Monitor.

For details, see “Setting Up the Machine”, Security Reference.

Be sure to read this manual when setting the enhanced security functions, or user and administrator
authentication.

PostScript 3 Supplement

Explains how to set up and use PostScript 3.

Information

Contains general notes on the machine, and information about the trademarks of product names used
in the manuals.

Other Manuals

• UNIX Supplement

• Extended Feature Settings Reference <Device Version>

• Extended Feature Settings Reference <Web Version>

• App2Me Start Guide

• Manuals provided are specific to machine types.

• For "UNIX Supplement", please visit our Web site or consult an authorized dealer. This manual
includes descriptions of functions and settings that might not be available on this machine.

Product name General name

DeskTopBinder Lite and DeskTopBinder Professional*1 DeskTopBinder

*1 Optional
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How to Read This Manual

Symbols

This manual uses the following symbols:

Indicates points to pay attention to when using the machine, and explanations of likely causes of paper
misfeeds, damage to originals, or loss of data. Be sure to read these explanations.

Indicates supplementary explanations of the machine’s functions, and instructions on resolving user errors.

This symbol is located at the end of sections. It indicates where you can find further relevant information.

[ ]
Indicates the names of keys on the machine's display or control panels.

About IP Address

In this manual, “IP address” covers both IPv4 and IPv6 environments. Read the instructions that are relevant
to the environment you are using.
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1. Windows Configuration

Using the Standard TCP/IP Port

Installing the PostScript 3 Printer Driver (Windows 2000)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the DeskTop Binder-
SmartDeviceMonitor port.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer], and then click [Next >].

7. Click [Create a new port:].

8. Click [Standard TCP/IP Port], and then click [Next >].

9. Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

10. Enter the printer name or IP address in the [Printer Name or IP Address] box, and then click
[Next >].

The [Port Name] text box automatically obtains a port name. Change this name if necessary.

When screen for Device selection appears, select “RICOH NetworkPrinter Driver C Model”.

11. Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

12. Check that the name of the machine whose driver you want to install is selected, and then
click [Next >].

13. Change the printer name if you want, specify whether or not to configure the printer as
default, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

9
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14. Specify whether or not to share the printer, and then click [Next >].

15. Specify whether or not to print a test page, and then click [Next >].

16. Click [Finish].

The printer driver installation starts.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch “Setup.exe” on
the CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows XP, Windows Server
2003/2003 R2)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the DeskTop Binder-
SmartDeviceMonitor port.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the supplier's Web site.

• If your operating system is Windows XP Professional x64, Windows Server 2003/2003 R2 x64,
you must download the printer driver from the manufacturer's Web site. Select this printer and the
operating system you are using, and then download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer attached to this printer], and then click [Next >].

7. Click [Create a new port:].

8. Click [Standard TCP/IP Port] in [Create a new port], and then click [Next >].

9. Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

1. Windows Configuration
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10. Enter the printer name or IP address in the [Printer Name or IP Address] box.

The [Port Name] text box automatically obtains a port name. Change this name if necessary.

When screen for Device selection appears, select “RICOH NetworkPrinter Driver C Model”.

11. Click [Next >].

12. Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

13. Check that the name of the machine whose driver you want to install is selected, and then
click [Next >].

14. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

15. Specify whether or not to share the printer, and then click [Next >].

16. Specify whether or not to print a test page, and then click [Next >].

17. Click [Finish].

The printer driver installation starts.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch “Setup.exe” on
the CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows Vista, Windows Server 2008)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the DeskTop Binder-
SmartDeviceMonitor port.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the supplier's Web site.

• If your operating system is Windows Vista x64, Windows Server 2008 x64, you must download the
printer driver from the manufacturer's Web site. Select this printer and the operating system you are
using, and then download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Using the Standard TCP/IP Port
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3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Add a local printer].

6. Click [Create a new port:], and then select [Standard TCP/IP Port] in [Type of port:].

7. Click [Next].

8. Select [TCP/IP Device] in [Device Type:].

9. Enter the printer's IP address in [Hostname or IP Address], and then click [Next>].

The [Port Name] text box automatically obtains a port name. Change this name if necessary.

A printer driver installation screen appears when Standard TCP/IP port is detected.

When screen for Device selection appears, select “RICOH NetworkPrinter Driver C Model”.

10. Select that the name of the printer whose driver you want to install is selected, and then click
[Next >].

11. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

12. Specify whether or not to share the printer, and then click [Next >].

13. Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch “Setup.exe” on
the CD-ROM root directory.

1. Windows Configuration
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Using the IPP Port

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

• In an IPv6 environment, you cannot use the IPP Port. Use the SmartDeviceMonitor for Client port.

• The IPP port cannot be used under Windows 2000. If you are using Windows 2000, install the
PostScript 3 printer driver using the SmartDeviceMonitor for Client port. To use the
SmartDeviceMonitor for Client port, you must first download SmartDeviceMonitor for Client from the
supplier's Website. For details about the SmartDeviceMonitor for Client port, see "Using the
DeskTopBinder-SmartDeviceMonitor for Client Port".

• To print via IPP-SSL under Windows Vista or Windows Server 2008, you must install the certificate
on your computer before you install the printer driver using the IPP port. For details, consult your
administrator.

Installing the PostScript 3 Printer Driver (Windows XP, Windows Server
2003/2003 R2)

1. Quit all applications currently running.

2. On the [Start] menu, click [Printers and Faxes].

3. Click [Add a printer].

The [Add printer Wizard] dialog box appears.

4. Click [Next>].

5. Click [A network printer, or a printer attached to another computer].

6. Click [Next>].

7. Click [Connect to a printer on the Internet or on a home or official network:].

8. In the [URL:] box, enter "http:// printer's IP address/ printer (or ipp)" as the printer's
address, and then click [Next>].

9. Click [Have Disk...].

10. Insert the provided CD-ROM into the computer's CD-ROM drive.

If the [AutoPlay] dialog box appears, click the [close] button.

11. Click [Browse...], and then specify a location for the inf file.

If the CD-ROM drive letter is D, the printer driver's source files are stored in "D:\DRIVERS\PS
\XP_VISTA\(Language)\DISK1".

12. Click [OK] to close the Install From Disk window.

Using the IPP Port
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13. Select the machine you want to use, and then click [OK].

Only machines that respond to a broadcast from the computer appear. To use a machine not listed
here, click [Specify Address], and then enter the IP address or host name of the machine.

14. Configure the default printer as necessary, and then click [Next >].

If the [Windows can't verify the publisher of this driver software] message appears, click [Install this
driver software anyway].

15. Click [Finish].

If installation is successful, the icon of the printer connected to the IPP port is added to the [Printers
and Faxes] window.

• To stop installation of the selected driver, click [Cancel] before installation is complete.

• p.20 "Using the DeskTop Binder-SmartDeviceMonitor for Client Port"

Installing the PostScript 3 Printer Driver (Windows Vista, Windows Server 2008)

1. Quit all applications currently running.

2. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

3. Click [Printers] in [Hardware and Sound].

4. Click [Add a printer] in [Printers].

The [Add printer] dialog box appears.

5. Click [Add a network, wireless or Bluetooth printer].

6. Click [The printer that I want isn't listed].

7. Insert the provided CD-ROM into the computer's CD-ROM drive.

If the [AutoPlay] dialog box appears, click the [close] button.

8. Click [Select a shared printer by name].

9. Enter "http:// machine's IP address/printer (or ipp)" as the machine's address, and then
click [Next].

10. Click [Have Disk...].

11. Click [Browse...], and then specify a location for the inf file.

If the CD-ROM drive letter is D, the printer driver's source files are stored in "D:\DRIVERS\PS
\XP_VISTA\(Language)\DISK1".

12. Click [Open].

1. Windows Configuration
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13. Click [OK] to close the Install From Disk window.

14. Select the machine you want to use, and then click [OK].

Only machines that respond to a broadcast from the computer appear. To use a machine not listed
here, click [Specify Address], and then enter the IP address or host name of the machine.

15. Configure the default printer as necessary, and then click [Next].

If the [Windows can't verify the publisher of this driver software] message appears, click [Install this
driver software anyway].

16. Specify whether or not to print a test page, and then click [Finish].

If installation is successful, the icon of the printer connected to the IPP port is added to the [Printers]
window.

• To stop installation of the selected driver, click [Cancel] before installation is complete.

• p.20 "Using the DeskTop Binder-SmartDeviceMonitor for Client Port"

Using the IPP Port
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Using the LPR Port

Installing the PostScript 3 Printer Driver (Windows 2000)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer], and then click [Next >].

7. Click [Create a new port:].

8. Click [LPR Port], and then click [Next >].

9. Enter the printer's IP address in the [Name or address of server providing lpd] box.

10. Enter “Ip” in the [Name of printer or print queue on that server] box, and then click [OK].

11. Check that the name of the machine whose driver you want to install is selected, and then
click [Next >].

12. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

13. Specify whether or not to share the printer, and then click [Next >].

14. Specify whether or not to print a test page, and then click [Next >].

15. Click [Finish].

The printer driver installation starts.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch “Setup.exe” on
the CD-ROM root directory.

1. Windows Configuration
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Installing the PostScript 3 Printer Driver (Windows XP, Windows Server
2003/2003 R2)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• In an IPv6 environment, you cannot use the LPR Port. Use the DeskTop Binder-SmartDeviceMonitor
port.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the supplier's Web site.

• If your operating system is Windows XP Professional x64, Windows Server 2003/2003 R2 x64,
you must download the printer driver from the manufacturer's Web site. Select this printer and the
operating system you are using, and then download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer attached to this computer.], and then click [Next >].

7. Click [Create a new port:].

8. Click [LPR Port] in [Create a new port], and then click [Next >].

9. Enter the printer's IP address in the [Name or address of server providing lpd] box.

10. Enter “Ip” in the [Name of printer or print queue on that server] box, and then click [OK].

11. Check that the name of the machine whose driver you want to install is selected, and then
click [Next >].

12. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

13. Specify whether or not to share the printer, and then click [Next >].

14. Specify whether or not to print a test page, and then click [Next >].

15. Click [Finish].

The printer driver installation starts.

Using the LPR Port
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• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch “Setup.exe” on
the CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows Vista, Windows Server 2008)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• In an IPv6 environment, you cannot use the LPR Port. Use the DeskTop Binder-SmartDeviceMonitor
port.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the supplier's Web site.

• If your operating system is Windows Vista x64, Windows Server 2008 x64, you must download the
printer driver from the manufacturer's Web site. Select this printer and the operating system you are
using, and then download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Add a local printer].

6. Click [Create a new port:], and then click [LPR Port] in [Type of port:].

7. Click [Next].

8. Enter the printer's IP address in the [Name or address of server providing lpd] box.

9. Enter “Ip” in the [Name of printer or print queue on that server] box, and then click [OK].

10. Select that the name of the printer whose driver you want to install is selected, and then click
[Next >].

11. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

1. Windows Configuration
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12. Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch “Setup.exe” on
the CD-ROM root directory.

Using the LPR Port
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Using the DeskTop Binder-SmartDeviceMonitor
for Client Port

Installing DeskTop Binder-SmartDeviceMonitor for Client

This describes how to install the the printer driver using the SmartDeviceMonitor for Client.

To use this function, you must first download SmartDeviceMonitor for Client from the supplier's Website
and install it on your computer. Contact your local dealer for information on downloading
SmartDeviceMonitor for Client.

• To install DeskTop Binder-SmartDeviceMonitor for Client, you must have an account that has Manage
Printers permission. Log on as an Administrator.

• Install DeskTop Binder-SmartDeviceMonitor for Client before installing the printer driver when using
the DeskTop Binder-SmartDeviceMonitor for Client port.

Installing the PostScript 3 Printer Driver (Windows 2000 - TCP/IP)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer], and then click [Next >].

7. Click [Create a new port:].

8. Click [DeskTop Binder - SmartDeviceMonitor], and then click [Next >].

9. Click [TCP/IP], and then click [Search].

A list of printers using TCP/IP appears.

1. Windows Configuration
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10. Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use a machine not listed
here, click [Specify Address], and then enter the IP address or host name of the machine.

11. Check that the name of the machine whose driver you want to install is selected, and then
click [Next >].

12. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

13. Specify whether or not to share the printer, and then click [Next >].

14. Specify whether or not to print a test page, and then click [Next >].

15. Click [Finish].

The printer driver installation starts.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch “Setup.exe” on
the CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows 2000 - IPP)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer attached to this computer], and then click [Next >].

7. Click [Create a new port:].

8. Click [DeskTop Binder - SmartDeviceMonitor], and then click [Next >].

9. Click [IPP].
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10. In the [Printer URL] box, enter “http://(machine's IP address or host name)/printer” as the
printer's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted communication), enter
“https://(machine's IP address or host name)/printer” (Internet Explorer 5.01, or a higher version
must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter “http://machine's IP address or host name/ipp” as the printer's address.

If the address is “192.168.001.010”, you must enter it as “192.168.1.10” to connect to the machine.

11. Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the
name of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port
name.

12. Click [Detailed Settings] to configure proxy server, the IPP user name and other settings.
Specify the necessary settings, and then click [OK].

For information about the settings, see DeskTop Binder-SmartDeviceMonitor for Client Help.

13. Click [OK].

14. Check that the name of the machine whose driver you want to install is selected, and then
click [Next >].

15. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the machine as default.

16. Specify whether or not to share the printer, and then click [Next >].

17. Specify whether or not to print a test page, and then click [Next >].

18. Click [Finish].

The printer driver installation starts.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch “Setup.exe” on
the CD-ROM root directory.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows Server
2003/2003 R2 - TCP/IP)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the supplier's Web site.

• If your operating system is Windows XP Professional x64, Windows Server 2003/2003 R2 x64,
you must download the printer driver from the manufacturer's Web site. Select this printer and the
operating system you are using, and then download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer attached to this computer.], and then click [Next >].

7. Click [Create a new port:].

8. Click [DeskTop Binder - SmartDeviceMonitor], and then click [Next >].

9. Click [TCP/IP], and then click [Search].

A list of printers using TCP/IP appears.

10. Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use a machine not listed
here, click [Specify Address], and then enter the IP address or host name of the machine.

11. Check that the name of the machine whose driver you want to install is selected, and then
click [Next >].

12. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

13. Specify whether or not to share the printer, and then click [Next >].

14. Specify whether or not to print a test page, and then click [Next >].

15. Click [Finish].

The printer driver installation starts.
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• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch “Setup.exe” on
the CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows XP, Windows Server
2003/2003 R2 - IPP)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the supplier's Web site.

• If your operating system is Windows XP Professional x64, Windows Server 2003/2003 R2 x64,
you must download the printer driver from the manufacturer's Web site. Select this printer and the
operating system you are using, and then download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer attached to this computer.], and then click [Next >].

7. Click [Create a new port:].

8. Click [DeskTop Binder - SmartDeviceMonitor], and then click [Next >].

9. Click [IPP].

10. In the [Printer URL] box, enter “http://(machine's IP address or host name)/printer” as the
printer's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted communication), enter
“https://(machine's IP address or host name)/printer” (Internet Explorer 5.01, or a higher version
must be installed).

(example IP address: 192.168.15.16)
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http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter “http://machine's IP address or host name/ipp” as the printer's address.

If the address is “192.168.001.010”, you must enter it as “192.168.1.10” to connect to the machine.

11. Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the
one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port
name.

12. Click [Detailed Settings] to make necessary settings.

For information about the settings, see DeskTop Binder-SmartDeviceMonitor for Client Help.

13. Click [OK].

14. Check that the name of the printer driver you want to install is selected, and then click [OK].

15. Change the name of the printer if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

16. Specify whether or not to share the printer, and then click [Next >].

17. Specify whether or not to print a test page, and then click [Next >].

18. Click [Finish].

The printer driver installation starts.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch “Setup.exe” on
the CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows Vista, Windows Server 2008
- TCP/IP)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the supplier's Web site.

• If your operating system is Windows Vista x64, Windows Server 2008 x64, you must download the
printer driver from the manufacturer's Web site. Select this printer and the operating system you are
using, and then download it.
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1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Add a local printer].

6. Click [Create a new port:] and then select [DeskTop Binder - SmartDeviceMonitor] in [Type
of port:].

7. Click [Next >].

8. Click [TCP/IP], and then click [Search].

A list of printers using TCP/IP appears.

9. Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use a machine not listed
here, click [Specify Address], and then enter the IP address or host name of the machine.

10. Check that the name of the machine whose driver you want to install is selected, and then
click [Next >].

11. Change the printer name if you want, and then click [Next >].

12. Specify whether or not to share the printer, and then click [Next >].

13. Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch “Setup.exe” on
the CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows Vista, Windows Server 2008
- IPP)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.
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• You can install the printer driver from the CD-ROM provided with this machine or download it from
the supplier's Web site.

• If your operating system is Windows Vista x64, Windows Server 2008 x64, you must download the
printer driver from the manufacturer's Web site. Select this printer and the operating system you are
using, and then download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Add a local printer].

6. Click [Create a new port:] and then select [DeskTop Binder - SmartDeviceMonitor] in [Type
of port:].

7. Click [Next >].

8. Click [IPP].

9. In the [Printer URL] box, enter “http://(machine's IP address or host name)/printer” as the
printer's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted communication), enter
“https://(machine's IP address or host name)/printer” (Internet Explorer 5.01, or a higher version
must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter “http://machine's IP address or host name/ipp” as the printer's address.

If the address is “192.168.001.010”, you must enter it as “192.168.1.10” to connect to the machine.

10. Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the
one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port
name.

11. Click [Detailed Settings] to make necessary settings, and then click [Next >].

For information about the settings, see DeskTop Binder-SmartDeviceMonitor for Client Help.

12. Click [OK].

Using the DeskTop Binder-SmartDeviceMonitor for Client Port

27

1



13. Check that the name of the printer driver you want to install is selected, and then click [Next
>].

14. Change the name of the printer if you want, and then click [Next >].

15. Specify whether or not to share the printer, and then click [Next >].

16. Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch “Setup.exe” on
the CD-ROM root directory.

Changing the Port Settings DeskTop Binder-SmartDeviceMonitor for Client

Follow the procedure below to change the DeskTop Binder-SmartDeviceMonitor for Client settings, such
as TCP/IP timeout, recovery/parallel printing, and printer groups.

Windows 2000:

1. Open the [Printers] window from the [Start] menu.

2. Click the icon of the printer you want to use. On the [File] menu, click [Properties].

The printer properties appear.

3. On the [Ports] tab, click [Configure Port].

The [Port Configuration] dialog box appears.

Windows XP, Windows Server 2003 / 2003 R2:

1. Open the [Printers and Faxes] window from the [Start] menu.

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use. On the [File] menu, click [Properties].

The printer properties appear.

3. Click the [Port] tab, and then click [Configure Port].

The [Port Configuration] dialog box appears.

• For TCP/IP, timeout setting can be configured.

• User, proxy, and timeout settings can be configured for IPP.
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• For information about these settings, see DeskTop Binder-SmartDevice Monitor for Client Help.

Windows Vista, Windows Server 2008:

1. Open the [Printers] window from [Control Panel] on the [Start] menu.

The [Printers] window appears.

2. Right-click the icon of the printer you want to use, and then click the [Properties].

The printer properties appear.

3. Click the [Port] tab, and then click [Configure Port].

The [Port Configuration] dialog box appears.

• For TCP/IP, timeout setting can be configured.

• User, proxy, and timeout settings can be configured for IPP.

• For information about these settings, see DeskTop Binder-SmartDevice Monitor for Client Help.

How to enable Recovery/Parallel Printing

If no settings on the [Recovery/Parallel Printing] tab are available, follow the procedure below.

1. Start DeskTop Binder-SmartDeviceMonitor for Client, and then right-click the DeskTop
Binder-SmartDeviceMonitor for Client icon on the taskbar.

2. Click [Extended Features Settings], and then select the [Set Recovery/Parallel Printing for
each port] check box.

3. Click [OK] to close the [Extended Features Settings] dialog box.
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Using as the Windows Network Printer

Installing the PostScript 3 Printer Driver (Windows 2000)

• Installing a printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• If you print from a print server connected to the printer using the DeskTop Binder-
SmartDeviceMonitor port, the client cannot use Recovery Printing and Parallel Printing.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Network printer], and then click [Next >].

7. Select the location method from the [Locate Your Printer] screen, and then click [Next >].

8. Double-click the computer name you want to use as a print server in the [Shared printers]
window.

9. Select the printer you want to use, and then click [Next >].

The printer driver installation starts.

10. Click [Next >].

Select the [Yes] check box to configure the printer as default.

11. Click [Finish].

Restart the computer to complete installation.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch “Setup.exe” on
the CD-ROM root directory.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows Server
2003/2003 R2)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• If you print from a print server connected to the printer using the DeskTop Binder-
SmartDeviceMonitor port, the client cannot use Recovery Printing and Parallel Printing.

• If you print with a Windows XP or Windows Server 2003/2003 R2 print server, DeskTop Binder-
SmartDeviceMonitor notification functions may not be possible for the client.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the supplier's Web site.

• If your operating system is Windows XP Professional x64, Windows Server 2003/2003 R2 x64,
you must download the printer driver from the manufacturer's Web site. Select this printer and the
operating system you are using, and then download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [A network printer, or a printer attached to another computer] and then click [Next >].

7. Select [Browse for a printer], and then click [Next >].

8. Double-click the computer name you want to use as a print server in the [Shared printers]
window.

9. Select the printer you want to use, and then click [Next >].

The printer driver installation starts.

10. Click [Next >].

Select the [Yes] check box to configure the printer as default.

11. Click [Finish].

Restart the computer to complete installation.
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• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch “Setup.exe” on
the CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows Vista, Windows Server 2008)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• If you print from a print server connected to the printer using the DeskTop Binder-
SmartDeviceMonitor port, the client cannot use Recovery Printing and Parallel Printing.

• If you print with a Windows Vista print server, DeskTop Binder-SmartDeviceMonitor notification
functions may not be possible for the client.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the supplier's Web site.

• If your operating system is Windows Vista x64, Windows Server 2008 x64, you must download the
printer driver from the manufacturer's Web site. Select this printer and the operating system you are
using, and then download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Add a network, wireless or Bluetooth printer].

6. Select your printer, and then click [Next >].

7. Select that the name of the printer whose driver you want to install is selected, and then click
[Next >].

8. Change the printer name if you want, and then click [Next >].

Select the check box to configure the machine as default.

9. Specify whether or not to share the printer, and then click [Next >].
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10. Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

Restart the computer to complete installation.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch “Setup.exe” on
the CD-ROM root directory.

Using the WSD port

This section explains installation when using the WSD port.

• The WSD Port can be used only under Windows Vista, or Windows Server 2008.

• To install under Windows Vista, you must have an account that has Manage Printers permission. Log
on as an Administrator.

• If the machine is connected using the WSD port, bi-directional communication is not possible. For
details about bi-directional communication, see "Making Option Settings for the Printer".

• You can connect to the machine only if both the machine and computer are on the same network
segment, or Windows Vista "Network discovery" is enabled. For details, see Windows Help.

1. Quit all applications currently running.

2. Click [Start], and then click [Network].

The [Network] window appears, and the device search begins automatically.

3. Right-click the printer's icon, and then click [Install].

If the [User Account Control] dialog box appears, click [Continue].

The [Found New Hardware] dialog box appears.

4. Click [Locate and install driver software (recommended)].

If the [User Account Control] dialog box appears, click [Continue].

The [Found New Hardware] window appears.

5. Click [Don't search online].

6. Click [Browse my computer for driver software (advanced)].

7. Insert the provided CD-ROM into the computer's CD-ROM drive.

If the [AutoPlay] dialog box appears, click the [close] button and then proceed to step 8.
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8. Click [Browse...], and then specify a location for the printer driver.

If the CD-ROM drive letter is D, the printer driver's source files are stored in “D:\DRIVERS\PS
\XP_VISTA\ (Language) \DISK1”.

9. Click [Next].

If the [Windows can't verify the publisher of this driver software] message appears, click [Install this
driver software anyway].

10. Click [Close].

If installation is successful, the icon of the printer connected to the "WSD" port is added to the [Printers]
window.

• The port name that follows "WSD" uses random character strings. It cannot be changed freely.

• To stop the installation, click [Cancel] before the installation is complete. When re-installing the WSD
Port, right-click the machine's icon in the [Network] window, and then click [Uninstall].

• p.46 "Making Option Settings for the Printer"
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Using as the NetWare Print Server / Remote
Printer

When using the PostScript 3 Printer Driver

• In an IPv6 environment, Netware servers cannot be used.

Follow the procedure below to set up the PostScript 3 printer driver.

1. In the [Printers] or [Printers and Faxes] window, open the printer properties.

2. Click the [Device Settings] tab.

3. Select a [No] on the [Send CTRL+D Before Each Job:] and [Send CTRL+D After Each Job:],
and then click [Apply].

4. Click [OK] to close the printer properties dialog box.
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Installing the Printer Driver Using USB
This section explains how to install printer drivers using USB.

• Make sure that machine is connected to the computer's USB ports using the USB interface cable.

• Before installing, check that only the operating system is running on the computer and no print jobs
are in progress.

• The printer drivers can be installed from the CD-ROM provided with this machine.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the supplier's Web site.

• If your operating system is Windows XP Professional x64, Windows Vista x64, or Windows Server
2003/2003 R2/2008 x64, you must download the printer driver from the manufacturer's Web site.
Select this printer and the operating system you are using, and then download it.

Windows 2000 - USB

• Installing a printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer
connected to the “USB” port is added to the [Printers] window.

If the printer driver is not installed, follow the plug-and-play instructions of the printer to install it from the
CD-ROM provided.

1. Check that the power of the machine is off.

2. Connect the machine to the computer using the USB cable.

Connect the USB cable firmly.

3. Turn on the power of the machine.

Found New Hardware Wizard starts, and USB Printing Support is installed automatically.

4. In the Found New Hardware Wizard window, click [Search for a suitable driver for my
device [recommended]], and then click [Next >].

5. Select the [Specify location] check box, and then click [Next >].

6. Insert the CD-ROM into the CD-ROM drive.

If Auto Run starts, click [Cancel] and then [Exit].

7. Specify the location where the source files of the printer driver is stored.

If the CD-ROM drive is D, the source files of the printer driver are stored in the following location:
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• PostScript 3

D:\DRIVERS\PS\XP_VISTA\(Language)\DISK1

8. Check the printer driver location, and then click [OK].

9. Click [Next >].

10. Click [Finish].

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer
connected to the “USB001” port is added to the [Printers] window.

• To disable Auto Run, press the left shift key when inserting the CD-ROM into the drive and keep it
pressed until the computer finishes reading from the CD-ROM.

• The number after “USB” varies depending on the number of printers connected.

Windows XP, Windows Server 2003/2003 R2 - USB

• Installing a printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer
connected to the “USB” port is added to the [Printers and Faxes] window.

The printer drivers can be installed from the CD-ROM provided with this machine.

If the printer driver is not installed, follow the plug-and-play instructions of the printer to install it from the
CD-ROM provided.

1. Check that the power of the machine is off.

2. Connect the machine to the computer using the USB cable.

Connect the USB cable firmly.

3. Turn on the power of the machine.

Found New Hardware Wizard starts, and USB Printing Support is installed automatically.

4. In the Found New Hardware Wizard window, click [Install from a list or specific location
(Recommended)], and then click [Next >].

5. Insert the CD-ROM into the CD-ROM drive.

If Auto Run starts, click [Cancel], and then [Exit].

6. Select the [Include this location in the search] check box under [Search for the best driver in
these location], and then click [Browse] to select the printer driver location.

If the CD-ROM drive is D, the source files of the printer driver are stored in the following location:

• PostScript 3
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D:\DRIVERS\PS\XP_VISTA\(Language)\DISK1

7. Check the printer driver location, and then click [Next >].

8. Click [Continue].

9. Click [Finish].

If installation is successful, the icon of the printer connected to the “USB001” port is added to the
[Printers and Faxes] window.

• To disable Auto Run, press the left Shift key when inserting the CD-ROM into the drive and keep it
pressed until the computer finishes reading from the CD-ROM.

• The number after “USB” varies depending on the number of printers connected.

Windows Vista, Windows Server 2008 - USB

• Installing a printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer
connected to the “USB” port is added to the [Printers] window.

The printer drivers can be installed from the supplied CD-ROM provided with this machine.

If the printer driver is not installed, follow the plug-and-play instructions of the printer to install it from the
supplied CD-ROM.

1. Check that the power of the machine is off.

2. Connect the machine to the computer using the USB cable.

Connect the USB cable firmly.

3. Turn on the power of the machine.

Found New Hardware Wizard starts, and USB Printing Support is installed automatically.

4. In the Found New Hardware Wizard window, select [Locate and install driver software
(recommended)].

Click [Continue] if the [User Account Control] window appears.

5. When a message prompting insertion of the CD-ROM, insert the CD-ROM into the CD-ROM
drive.

Installation of the printer driver is automatically started.

If "Windows can't verify the publisher of this software" display appears in the installation, select the
[Install this driver software anyway].
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6. Click [Exit].

If installation is successful, the icon of this machine connected to the "USB001" port is added to the
[Printers] window.

• To disable Auto Run, press the left Shift key when inserting the CD-ROM into the drive and keep it
pressed until the computer finishes reading from the CD-ROM.

• The number after “USB” varies depending on the number of printers connected.

Troubleshooting for using USB

Problems Solutions

The machine is not automatically recognized.
Turn off the power of the machine, reconnect the
USB cable, and then turn it on again.

Windows has already configured the USB settings.

Open Windows' Device Manager, and then,
under [Universal Serial Bus controllers], remove
any conflicting devices. Conflicting devices have a
yellow [!] or [?] icon by them. Take care not to
accidentally remove required devices. For details,
see Windows Help.

• When using Windows 2000/XP/Vista or Windows Server 2003/2003 R2/2008, an erroneous
device is displayed under [USB Controller] in the [Device Manager] dialog box.

Installing the Printer Driver Using USB
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Printing with Parallel Connection
To use a machine connected using a parallel interface, click [LPT1] when installing the printer driver.

Installing the PostScript 3 printer driver (Windows 2000)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer], and then click [Next >].

A dialog box for selecting the printer manufacturer and model name appears.

7. Select [LPT1] at the [Printer Port] dialog box, and then click [Next >].

8. Select whether or not to share the printer, and then click [Next >].

9. Select the name of the machine whose driver you want to install, and then click [Next >].

10. Select whether or not you want to print a test page, and then click [Finish].

The printer driver installation starts.

11. Restart the computer to complete installation if necessary.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch “Setup.exe” on
the CD-ROM root directory.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows Server
2003/2003 R2)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the supplier's Web site.

• If your operating system is Windows XP Professional x64, Windows Server 2003/2003 R2 x64,
you must download the printer driver from the manufacturer's Web site. Select this printer and the
operating system you are using, and then download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer attached to this computer], and then click [Next >].

7. Select the port you want to use, and then click [Next >].

A dialog box for selecting the printer manufacturer and model name appears.

8. Select the name of the machine whose driver you want to install, and then click [Next >].

9. Click [Close] to close the [Printer Port] dialog box.

10. Click [Next >].

11. Change the printer name if you want, and then click [Next >].

12. Select whether or not to share the printer, and then click [Next >].

13. Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

14. Restart the computer to complete installation.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch “Setup.exe” on
the CD-ROM root directory.
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Installing the PostScript 3 Printer Driver (Windows Vista, Windows Server 2008)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the supplier's Web site.

• If your operating system is Windows Vista x64, Windows Server 2008 x64, you must download the
printer driver from the manufacturer's Web site. Select this printer and the operating system you are
using, and then download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Add a local printer].

6. Select the port you want to use, and then click [Next >].

A dialog box for selecting the printer manufacturer and model name appears.

7. Select the name of the machine whose driver you want to install, and then click [Next >].

8. Change the machine name if you want, and then click [Next >].

9. Specify whether or not to share the machine, and then click [Next >].

10. Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

Restart the computer to complete installation.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch “Setup.exe” on
the CD-ROM root directory.
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Printing with Bluetooth Connection
For details about printing with Bluetooth, see "Printing with Bluetooth Connection", Network Guide.
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If a Message Appears during Installation
Message number 58 or 34 indicates the printer driver cannot be installed using Auto Run. Install the printer
driver using [Add Printer] or [Install Printer].

For Windows 2000:

1. On the [Start] menu, point to [Settings], and then click [Printers].

2. Double-click the Add Printer icon.

3. Follow the instructions in Add Printer Wizard.

• If the printer driver is on a CD-ROM, the location of the PostScript 3 printer driver is D:\DRIVERS\PS
\XP_VISTA\(Language)\DISK1.

• If the installer starts, click [Cancel] to quit.

For Windows XP Professional and Windows Server 2003/2003 R2:

1. On the [Start] menu, click [Printers and Faxes].

2. Click [Add a printer].

3. Follow the instructions in Add Printer Wizard.

• If the printer driver is on a CD-ROM, the location of the PostScript 3 printer driver is D:\DRIVERS\PS
\XP_VISTA\(Language)\DISK1. If the installer starts, click [Cancel] to quit.

• If the installer starts, click [Cancel] to quit.

For Windows XP Home Editions:

1. On the [Start] menu, click [Control Panel].

2. Click [Printers and Other Hardware].

3. Click [Printers and Faxes].

4. Click [Install Printer].

5. Follow the instructions in Add Printer Wizard.

• If the printer driver is on a CD-ROM, the location of the PostScript 3 printer driver is D:\DRIVERS\PS
\XP_VISTA\(Language)\DISK1. If the installer starts, click [Cancel] to quit.

• If the installer starts, click [Cancel] to quit.
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For Windows Vista and Windows Server 2008:

1. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

2. Click [Printer] in “Hardware and Sound”.

3. Click [Install Printer].

4. Follow the instructions in Add Printer Wizard.

• If the printer driver is on a CD-ROM, the location of the PostScript 3 printer driver is D:\DRIVERS\PS
\XP_VISTA\(Language)\DISK1. If the installer starts, click [Cancel] to quit.

• If the installer starts, click [Cancel] to quit.
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Making Option Settings for the Printer
Make option settings for the machine using the printer driver when bidirectional communication is disabled.

Set up option settings when bidirectional communications are disabled.

• Manage Printers permission is required to change the printer properties in the [Printers] folder. Log
on as an Administrators or Power Users group member.

1. On the [Start] menu, click [Printers and Faxes] or [Printers].

The [Printers and Faxes] or [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

Under Windows Vista, Windows Server 2008, Right-click the icon of the printer you want to use, and
then click the [Properties].

4. Click the [Device Settings] tab.

5. Select options installed from the [Installable Options] area, and then make the necessary
settings.

6. Click [Apply], and then click [OK] to close the printer properties dialog box.

• For details about making option settings for the printer, see Setting Up Options.
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Setting Up the Printer Driver

Windows 2000 - Accessing the Printer

Making printer default settings - the printer properties

• To change the printer default settings including option configuration settings, log on using an account
that has Manage Printers permission. Members of the Administrators and Power Users groups have
Manage Printers permission by default.

• You cannot change the printer default settings for each user. Settings made in the printer properties
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The printer properties dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• Do not make a setting for [Form to Tray Assignment].

• For details, see the printer driver Help.

Making printer default settings - Printing Preferences

• When the printer driver is distributed from the print server, the setting values specified by the server
are displayed as the default for [Printing Defaults...].

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.
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4. Make the necessary settings, and then click [OK].

The setting is temporarily registered as [Unregistered] in the [One Click Presets list:] area.

• Settings you make here are used as the default settings for all applications.

• The [Unregistered] setting is invalid if the other One Click Presets icon is selected. If you wish to confirm
the [Unregistered] setting, click [Register Current Settings...]. For details about confirming the setting,
see "Making Printer Settings - One Click Presets".
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• For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application. The following explains how to make settings for the WordPad application provided with
Windows 2000.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Select Printer] list, and then click [Preferences].

3. Make the necessary settings, and then click [Apply].

• The procedure to open the [Printing Preferences] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• Any settings you make in the following procedure are valid for the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details, see the printer driver Help.

Making Printer Settings - One Click Presets

This section explains how to register and use one click presets.

Each function explained in this chapter is preconfigured and registered under [One Click Presets List:] on
the [One Click Presets] tab.
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You can apply the relevant setting simply by clicking on the one click preset name. This helps to avoid
incorrect settings and misprints.

One click presets can be added, modified, and deleted as required. They can also be shared for use by
different users. By using registered one click presets, users without in-depth knowledge of the printer driver
can utilize advanced printing functions easily.

Follow the procedure to register one click presets.

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. Select the machine, and then open the [Printing Preferences] dialog box in the document's
native application.

The [Printing Preferences] dialog box appears.

3. Make the settings you require.

4. Click [Register Current Settings...]. Enter a name and comment that describe the setting, and
then click [OK].

The newly registered icon appears with its registered name in the One Click Preset List: area.

5. Click [OK].

• Under Windows operating systems, this function is available through the PostScript 3 printer driver.

• For details about modifying and deleting one click presets, see the printer driver Help.

Windows XP, Windows Server 2003/2003 R2 - Accessing the Printer Properties

Making printer default settings - the printer properties

• To change the printer default settings including option configuration settings, log on using an account
that has Manage Printers permission. Members of the Administrators and Power Users groups have
Manage Printers permission by default.

• You cannot change the printer default settings for each user. Settings made in the printer properties
dialog box are applied to all users.

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The printer properties dialog box appears.
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4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• Do not make a setting for [Form to Tray Assignment].

• For details, see the printer driver Help.

Making printer default settings - Printing Preferences

• When the printer driver is distributed from the print server, the setting values specified by the server
are displayed as the default for [Printing Defaults...].

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the necessary settings, and then click [OK].

The setting is temporarily registered as [Unregistered] in the [One Click Presets list:] area.

• Settings you make here are used as the default settings for all applications.

• The [Unregistered] setting is invalid if the other One Click Presets icon is selected. If you wish to confirm
the [Unregistered] setting, click [Register Current Settings...]. For details about confirming the setting,
see "Making Printer Settings - One Click Presets".
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• For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application. The following explains how to make settings for the WordPad application provided with
Windows XP.
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1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Select Printer] list, and then click [Preferences].

3. Make the necessary settings, and then click [OK].

• The procedure to open the [Printing Preferences] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• Any settings you make in the following procedure are valid for the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details, see the printer driver Help.

Making Printer Settings - One Click Presets

This section explains how to register and use one click presets.

Each function explained in this chapter is preconfigured and registered under [One Click Presets List:] on
the [One Click Presets] tab.

You can apply the relevant setting simply by clicking on the one click preset name. This helps to avoid
incorrect settings and misprints.

One click presets can be added, modified, and deleted as required. They can also be shared for use by
different users. By using registered one click presets, users without in-depth knowledge of the printer driver
can utilize advanced printing functions easily.

Follow the procedure to register one click presets.

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. Select the machine, and then open the [Printing Preferences] dialog box in the document's
native application.

The [Printing Preferences] dialog box appears.

3. Make the settings you require.

4. Click [Register Current Settings...]. Enter a name and comment that describe the setting, and
then click [OK].

The newly registered icon appears with its registered name in the One Click Preset List: area.

5. Click [OK].
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• Under Windows operating systems, this function is available through the PostScript 3 printer driver.

• For details about modifying and deleting one click presets, see the printer driver Help.

Windows Vista, Windows Server 2008 - Accessing the Printer Properties

Making printer default settings - the printer properties

• To change the printer default settings including option configuration settings, log on using an account
that has Manage Printers permission. Members of the Administrators and Power Users groups have
Manage Printers permission by default.

• You cannot change the printer default settings for each user. Settings made in the printer properties
dialog box are applied to all users.

1. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

2. Click [Printer] in “Hardware and Sound”.

3. Right-click the icon of the printer you want to use, and then click the [Properties].

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• Do not make a setting for [Form to Tray Assignment].

• For details, see the printer driver Help.

Making printer default settings - Printing Preferences

• When the printer driver is distributed from the print server, the setting values specified by the server
are displayed as the default for [Printing Defaults...].

1. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

2. Click [Printer] in “Hardware and Sound”.
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3. Right-click the icon of the printer you want to use, and then click the [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the necessary settings, and then click [OK].

The setting is temporarily registered as [Unregistered] in the [One Click Presets list:] area.

• Settings you make here are used as the default settings for all applications.

• The [Unregistered] setting is invalid if the other One Click Presets icon is selected. If you wish to confirm
the [Unregistered] setting, click [Register Current Settings...]. For details about confirming the setting,
see "Making Printer Settings - One Click Presets".
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• For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application. The following explains how to make settings for the WordPad application provided with
Windows XP.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Select Printer] list, and then click [Preferences].

3. Make the necessary settings, and then click [OK].

• The procedure to open the [Printing Preferences] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• Any settings you make in the following procedure are valid for the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details, see the printer driver Help.

Making Printer Settings - One Click Presets

This section explains how to register and use one click presets.
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Each function explained in this chapter is preconfigured and registered under [One Click Presets List:] on
the [One Click Presets] tab.

You can apply the relevant setting simply by clicking on the one click preset name. This helps to avoid
incorrect settings and misprints.

One click presets can be added, modified, and deleted as required. They can also be shared for use by
different users. By using registered one click presets, users without in-depth knowledge of the printer driver
can utilize advanced printing functions easily.

Follow the procedure to register one click presets.

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. Select the machine, and then open the [Printing Preferences] dialog box in the document's
native application.

The [Printing Preferences] dialog box appears.

3. Make the settings you require.

4. Click [Register Current Settings...]. Enter a name and comment that describe the setting, and
then click [OK].

The newly registered icon appears with its registered name in the One Click Preset List: area.

5. Click [OK].

• Under Windows operating systems, this function is available through the PostScript 3 printer driver.

• For details about modifying and deleting one click presets, see the printer driver Help.
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2. Mac OS Configuration

Mac OS
This section explains how to configure a Mac OS to use EtherTalk and USB.

The following explains how to configure Mac OS 9.1. If you are not using Mac OS 9.1, see the manual
of the Mac OS you are using for details.

• For Mac OS 8.6 and higher. (Mac OS X Classic environment is supported.)

• The PostScript 3 printer driver is stored in the following folder on the CD-ROM.

Mac OS 8 and 9:PS Driver:(language):Disk1

Installing the PostScript 3 Printer Driver and PPD File

It is necessary to install a printer driver and PostScript Printer Description (PPD) files to print from a Mac
OS.

Follow the procedure below to install a printer driver and a PPD file into a Mac OS using Mac OS 8.6 and
higher.

PostScript 3 Printer Driver

1. Insert the CD-ROM into the CD-ROM drive.

2. Double-click the CD-ROM drive icon.

3. Double-click the [Mac OS 8 and 9] folder.

4. Double-click the [PS Driver] folder.

5. Double-click the folder of the language you use.

6. Open [Disk1], and then double-click the installer icon.

7. Follow the instructions on the screen.

PPD Files

1. Double-click the CD-ROM drive icon.

2. Double-click the [Mac OS 8 and 9] folder.

3. Double-click the [Printer Descriptions] folder.

4. Double-click the folder of the language you are using.
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5. Open the [DISK1] folder.

6. Drag the PPD file and the plugin file into [Printer Descriptions] in [Extensions] under [System
Folder].

7. Restart the Mac OS.

Setting Up PPD Files

• Make sure that the printers are connected to an AppleTalk network before performing the following
procedure.

1. On the [Apple] menu, click [Chooser].

2. Click the Adobe PS icon.

3. In the [Select a PostScript Printer:] list, click the name of the printer you want to use.

4. Click [Create].

5. Click the printer you want to use, and then click [Setup].

A PPD file is set up and the Adobe PS icon appears at the left of the printer name in the list. Follow the
procedure on Setting Up Options to make option settings; otherwise close the [Chooser] dialog box.

Setting Up Options

1. On the [Apple] menu, click [Chooser].

2. Click the Adobe PS icon.

3. In the [Select a PostScript Printer:] list, click the name of the printer you want to use, and
then click [Setup].

4. Click [Configure].

A list of options appears.

5. Select the option you want to set up, and then select an appropriate setting for it.

6. Click [OK].

The list of options closes.

7. Click [OK].

The [Chooser] dialog box appears.

8. Close the [Chooser] dialog box.
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• If the option you want to select is not displayed, PPD files may not be set up correctly. To complete
the setup, check the name of the PPD file displayed in the dialog box.

Installing Adobe Type Manager

• Quit all applications currently running before installation. Install ATM after you restart the computer.

1. Start a Mac OS.

2. Insert the CD-ROM into the CD-ROM drive.

3. Double-click the CD-ROM drive con.

4. Double-click the [Mac OS 8 and 9] folder.

5. Double-click the [ATM] folder.

6. Double-click the ATM 4.6.2 installer icon.

7. Follow the instructions on the screen.

8. When the procedure is complete, restart the computer. ATM will be completely installed only
after restarting.

9. On the [Apple] menu, open [Control Panel], and then click [~ATM].

10. The ATM control panel opens.

• For details about installation, see the operating instructions in the ATM folder.

Installing Screen fonts

Follow the procedure below to install screen fonts.

The screen fonts described below can be found in the [Fonts] folder on the CD-ROM.

1. Start a Mac OS.

2. Insert the CD-ROM into the CD-ROM drive.

The CD-ROM drive icon appears.

3. Double-click the CD-ROM drive icon.

The contents of the CD-ROM appear.

4. Double-click the [Mac OS 8 and 9] folder.

5. Double-click the [Fonts] folder.

Mac OS
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6. Double-click the [Screen font] folder.

7. Double-click the [TrueType] or [Type1] folder.

Select the font type you want to use.

8. Copy the fonts you want to install in [System Folder].

A confirmation message appears.

9. Click [OK].

The fonts are installed.

10. Restart the Mac OS.

Changing to EtherTalk

Follow the procedure below to configure to a Mac OS to use EtherTalk.

1. Open [Control Panel], and then double-click the AppleTalk icon.

2. On the [Connect via:] pop-up menu, click [Ethernet].

3. If you change zones, select a name on the [Current zone:] pop-up menu.

4. Close the AppleTalk control panel.

5. Restart the computer.

• The procedures used to configure Mac OS may vary depending on the Mac OS version. The following
describes how to configure Mac OS 9.1. If you are using a different version of Mac OS, use the
following procedures as a reference and see the manuals for your Mac OS version.

• Confirm the Connection to the Printer with TCP/IP.

• For information about installing applications required for EtherTalk, see the Mac OS manuals.

2. Mac OS Configuration

58

2



Mac OS X
This section explains how to configure a Mac OS X to use EtherTalk, USB and TCP/IP.

Follow the procedure below to configure Mac OS X 10.3.8. If you are not using Mac OS X 10.3.8, see
the manual of the Mac OS X you are using for details.

• For Mac OS X 10.1 or higher.

• The PPD files are stored in the following folder on the CD-ROM.

Mac OS X:Mac OS X PPD Installer

Installing the PPD Files

Follow the procedure below to install a PPD file to print from Mac OS X.

• You need an administrator name and a password (phrase). For details, consult your network
administrator.

1. Insert the CD-ROM into the CD-ROM drive.

2. Double-click the CD-ROM drive icon.

3. Double-click the [Mac OS X] folder.

4. Double-click the [MacOSX PPD Installer] folder.

5. Double-click the installer icon.

6. Follow the instructions on the screen.

Setting Up the PPD File

1. Start Printer Setup Utility.

2. Click [Add].

Mac OS X 10.4 or later

Click a printer that has “AppleTalk” indicated in the “Connection” column.

If the zone is set, click [More Printers...], and then select the zone from the second pop-up menu.

Other Mac OS X

Click [AppleTalk] on the first pop-up menu.

If the zone is set, select the zone from the second pop-up menu.

Mac OS X
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3. Select the printer, and then select its manufacturer from the [Printer Model:] pop-up menu.

Under Mac OS X 10.4 or later, you are using from the [Print Using] popup menu.

A list of printer types appears.

4. Select the PPD file for the model you are using, and then click [Add].

5. Quit Printer Setup Utility.

Setting Up Options

1. Start System Preferences.

2. Click [Print& Fax].

3. In the [Printer] list, click the name of the printer you want to use, and then click [Printer
Setup...].

4. Select the option you want to set up, and then select an appropriate setting for it.

5. Click [Apply Changes].

• If the option you want to select is not displayed, PPD files may not be set up correctly. To complete
the setup, check the name of the PPD file displayed in the dialog box.

Using USB Interface

Follow the procedure below to set up USB connection.

1. Start Printer Setup Utility.

2. Click [Add].

Mac OS X 10.4 or later

Click a printer that has “USB” indicated in the “Connection” column.

Other Mac OS X

Click [USB] on the pop-up menu.

The connected printer appears.

3. Select the printer, and then select its manufacturer from the [Printer Model:] pop-up menu.

Under Mac OS X 10.4 or later, you are using from the [Print Using] pop-up menu.

A list of printer types appears.

4. Select the connected printer from the list of printer models, and then click [Add].

5. Quit Printer Setup Utility.
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• When printing with a USB connection to a Macintosh computer, printer language does not change
automatically. Use the control panel on this printer to change printer language to [Auto Detect] or
[PS] before printing.

• USB2.0 can be used only with Mac OS X 10.3.3 or higher.

Using Bonjour (Rendezvous)

Follow the procedure below to print using Bonjour (Rendezvous) under Mac OS X 10.2.3 or higher.
Ethernet and wireless LAN connections can also be used.

1. Start Printer Setup Utility.

2. Click [Add].

Mac OS X 10.4 or later

Click a printer that has “Bonjour” indicated in the “Connection” column.

If the zone is set, click [More Printers...], and then select the zone from the second pop-up menu.

Other Mac OS X

Click [Rendezvous] on the pop-up menu.

If the zone is set, select the zone from the second pop-up menu.

3. Select the name of the connected printer from the list of printer models, and then click [Add].

Under Mac OS X 10.4 or later, Installable Options window appears. Select the option you want to
set up, and then select an appropriate setting for it, and then [Continue].

4. Quit Printer Setup Utility.

• When printing with a Rendezvous connection to a Macintosh computer, printer language does not
change automatically. Use the control panel on this printer to change printer language to [Auto Detect]
or [PS] before printing.

Changing to EtherTalk

Follow the procedure below to configure a Mac OS X to use EtherTalk.

• You need an administrator name and a password (phrase). For details, consult your network
administrator.

1. Open [System Preferences], and then click the Network icon.

2. Click [Built-in Ethernet] in the [Show:] list box.

Mac OS X
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3. Click the [AppleTalk] tab.

4. Select the [Make AppleTalk Active] check box.

5. To change AppleTalk zones, select a name from the [AppleTalk Zone:] pop-up menu.

6. When the settings are made, click [Apple Now].

• For information about installing applications required for EtherTalk, see the Mac OS manuals.
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Configuring the Printer
Use the control panel to enable AppleTalk. (The default is active.)

Configuring the Printer
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3. Using PostScript 3

Setting Up Options
To use installed options correctly, first set up the printer driver. If the options are not recognized, you cannot
use them, even though they are physically installed. The procedure to set up a printer driver varies
depending on the operating system.

Windows

• If your system is Windows 2000, Windows XP Professional, Windows Vista, or Windows Server
2003/2003 R2/2008, changing printer driver settings requires Manage Printers permission.
Members of Administrators and Power Users groups have Manage Printers permission by
default. When you change printer driver settings, log on with an account that has Manage Printers
permission.

• If you are using Adobe PageMaker 6.0, 6.5, or 7.0, you have to set up options in the Adobe
PageMaker's print dialog box.

You can set up any of the options using the following tabs:

Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

[Installable Options] on the [Device Settings]
tab.

Mac OS
For ethernet, [Chooser] on the Apple Menu. For
USB, [Change Setup] from the [Printing] menu to
open the Desktop printer.

Mac OS X
[Printer Setup...] in [Print & Fax] to open the
System Preferences.

• To set up options, access the printer driver from Windows. You cannot set up options if you
access the printer driver from an application.

Mac OS

• If you are using Mac OS X, this functions cannot be used.

You can set up all options using the [Chooser] dialog box.

• See, Making Option Settings for the Printer, Setting Up Options or Setting Up Options for the
installation method appropriate to your printing environment.
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Printing a Document
This documentation describes the specific printer functions and menus that are added by installing the PPD
file.

• On a Macintosh, Mac OS 8.6 or higher (Mac OS X Classic environment is supported.), or Mac OS
X 10.1 or higher is required.

• If you are using Mac OS X 10.1.x, the following functions cannot be used:

• Sample Print

• Locked Print

• Hold Print

• Stored Print

• Store and Print

• Document Server

• User Code

• Applications, such as PageMaker, that have their own drivers do not support the following functions:

• Sample Print

• Locked Print

• Hold Print

• Stored Print

• Store and Print

• Document Server

• User Code

• If you are using Mac OS X 10.2.x or higher, the Job Type function can be used.

• “Mac OS X” in the tables below refers to Mac OS X 10.2.3. Depending on the version, [Features x]
is displayed as [Set x] (x is a number). Make adjustments according to the version you use.

Job Type

Use this to select the type of print job.

The following table shows the tabs or menus where you can select this function.
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Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

[Job Type:] is displayed on the [Job Setup] menu in
the [Printing Preferences] dialog box.

Mac OS [Job Type:] on [Job Log] in the print dialog box.

Mac OS X [Job Type:] on [Job Log] in the print dialog box.

You can select the following items:

Normal Print

Select this for normal printing. The print job starts immediately after the print command is given.

Sample Print

Use this function to print only one set of a multiple print jobs.

The other sets are saved in the machine. The saved job can be printed from the machine's control
panel. You can also delete the saved job.

• The “User ID” can contain up to eight alphanumeric (a-z, A-Z, 0-9) characters.

• Entering the “User ID” helps you distinguish your print job from others.

• For details about how to use Sample Print, see Job Type.

Locked Print

Use this function to save documents in the machine memory with a password, and then edit and print
them as you want.

• The “User ID” can contain to eight alphanumeric (a-z, A-Z, 0-9) characters. The “Password”
must be 4-8 digits.

• Entering the “User ID” helps you distinguish your print job from others.

• For details about how to use Locked Print, see Job Type.

Hold Print

Use this function to temporarily hold a file in the machine, and print it from the computer or the machine's
control panel later.

• The “User ID” can contain up to eight alphanumeric (a-z, A-Z, 0-9) characters.

• The “File Name” can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.

• Entering the “User ID” helps you distinguish your print job from others.
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• For details about how to use Hold Print, see Job Type.

Stored Print

Use this function to store a file in the machine, and then print it from the computer or the machine's
control panel later.

• The “User ID” can contain up to eight alphanumeric (a-z, A-Z, 0-9) characters. The “Password”
must be 4-8 digits.

• The File Name can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.

• You can assign a password to a saved document, but password assignment is not mandatory.

• Entering the “User ID” helps you distinguish your print job from others.

• For details about how to use Stored Print, see Job Type.

Store and Normal Print

Use this function to print the file at once and also store the file in the printer.

• The “User ID” can contain up to eight alphanumeric (a-z, A-Z, 0-9) characters. The “Password”
must be 4-8 digits.

• The “File Name” can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.

• You can assign a password to a saved document, but password assignment is not mandatory.

• Entering the “User ID” helps you distinguish your print job from others.

• For details about how to use Stored Print, see Job Type.

Send to Document Server

Use this function to store hard disk documents that you want to print as well as documents you might
want to later combine or process for printing.

• The “File Name” can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.

• For details about the Document Server function, see “Accessing the Document Server”, Printer
Reference.
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How to Use Sample Print

Follow the procedure below to print a document using the Sample Print function.

Windows 2000/XP/Vista, Windows Server 2003/2003 R2/2008

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. Select the printer, and then open the [Printing Preferences] dialog box.

3. In the [Job Type:] list, click [Sample Print].

4. Click [Details...].

5. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters.

The user ID associates the user with his / her jobs.

6. Click [OK].

7. Click [OK] to close the printer properties dialog box.

If the application has a collate option, make sure it is not selected before sending a print job. The
printer driver automatically collates Sample Print jobs by default. If the collate option is selected in
the application's [Print] dialog box, there may be more prints than required.

8. Set the number of copies to two or more in the [Copies:] box under the [Basic] menu, and
then start the printing from the application's [Print] dialog box.

The sample print job is sent to the machine, and one set is printed.

9. Check the printed output to make sure the settings are correct.

If the settings are correct, perform the following steps to print the remaining sets.

If you want to delete saved jobs, see "Deleting Sample Print files".

10. On the machine's control panel, press the [Printer] key to display the printer screen.

11. Press [Print Jobs].

12. Press [Sample Print Job List].

A list of print files stored in the machine appears.

[User ID], [Date / Time] and [File Name] also appear.

13. Select the file you want to print by pressing it.

14. Press [Print].

15. Enter the new number of sets using the number keys if necessary, and then press [Yes].

You can enter up to 999 sets.

Press the [Clear/Stop] key to correct any entry mistakes.

When multiple files are selected without setting a quantity, 1 page less than the minimum number of
all settings is applied.
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The remaining sets are printed.

• Pressing the [Clear/Stop] key after you press [Yes] to print cancels printing The file will remain in the
machine.

• When printing finishes, the stored file is deleted.

• To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started, the file is deleted.

• If there is a print job outstanding, this will be printed before the sample print job.

• If the application has a collate option, make sure it is not selected before sending a print job. The
printer driver automatically collates Sample Print jobs by default. If the collate option is selected in
the application's [Print] dialog box, there may be more prints than required.

Mac OS/Mac OS X

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. Set the number of copies to two or more.

The sample print job is sent to the machine, and one set is printed.

3. In the pop-up menu, click [Job Log].

4. On the [Job Type:] pop-up menu, select [Sample Print].

5. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters.

The user ID associates the user with his / her jobs.

6. After making the necessary settings, click [Print].

7. Check the printed output to make sure the settings are correct.

If the settings are correct, perform the following steps to print the remaining sets.

If you want to delete saved jobs, see "Deleting Sample Print files".

8. On the machine's control panel, press the [Printer] key to display the printer screen.

9. Press [Print Jobs].

10. Press [Sample Print Job List].

A list of sample print files stored in the machine appears.

[User ID], [Date / Time] and [File Name] also appear.

11. Select the file you want to print by pressing it.

12. Press [Print].

13. Enter the new number of sets using the number keys. if necessary, and then press [Yes].

You can enter up to 999 sets.
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Press [Clear/Stop] to correct any entry mistakes.

When multiple files are selected without setting a quantity, 1 page less than the minimum number of
all settings is applied.

The remaining sets are printed.

• Pressing the [Clear/Stop] key after you press [Yes] to print cancels printing The file will remain in the
machine.

• When printing finishes, the stored file is deleted.

• To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started, the file is deleted.

• If there is a print job outstanding, this is printed before the sample print job.

Deleting a Sample Print File

If a printed document is not as required, you can delete the Sample Print file.

1. On the machine's control panel, press the [Printer] key to display the printer screen.

2. Press [Print Jobs].

3. Press [Stored Print Job List].

A list of sample print files stored in the machine appears.

4. Select the file you want to delete by pressing it.

To cancel a selection, press the highlighted jobs again.

Only one file can be selected at a time.

5. Press [Delete].

A confirmation screen appears.

6. Press [Yes] to delete the file.

The selected file is deleted.

How to Use Locked Print

Follow the procedure below to print a document using the Locked Print function.

Windows 2000/XP/Vista, Windows Server 2003/2003 R2/2008

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. Select the printer, and then open the [Printing Preferences] dialog box.

3. In the [Job Type:] list, click [Locked Print].
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4. Click the [Details...].

5. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters, and then enter a 4-8 digit password in the [Password:] box.

The user ID associates user with his / her jobs.

6. Click [OK].

7. Click [OK] to close the printer properties dialog box.

If the application has a collate option, make sure it is not selected before sending a print job. The
printer driver automatically collates Locked Print jobs by default. If the collate option is selected in the
application's [Print] dialog box, there may be more prints than required.

8. On the machine's control panel, press the [Printer] key to display the printer screen.

9. Press [Print Jobs].

10. Press [Locked Print Job List].

A list of locked print files stored in the machine appears.

[User ID], [Date / Time] and [File Name] also appear.

11. Select the file you want to print by pressing it.

12. Press [Print].

The password screen appears.

13. Enter the password using the number keys, and then press [OK].

A confirmation screen appears.

A confirmation screen will appear if the password is not entered correctly. Press [Exit] to enter the
password again.

When multiple print files are selected, the machine prints only files that correspond to the entered
password. The number of files is displayed on the confirmation screen.

14. Press [Yes].

The locked file is printed.

• Pressing the [Clear/Stop] key after you press [Yes] to print cancels printing The file will remain in the
machine.

• To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started, the file is deleted.

• If the application has a collate option, make sure it is not selected before sending a print job. The
printer driver automatically collates Locked Print jobs by default. If the collate option is selected in the
application's [Print] dialog box, there may be more prints than required.
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Mac OS/Mac OS X

1. In the application, click [Print] on the [File] menu.

The [Print] dialog box appears.

2. In the pop-up menu, click [Job Log].

3. On the [Job Type:] pop-up menu, click [Locked Print].

4. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters, and then enter a 4-8 digit password in the [Password:] box.

The user ID associates the user with his / her jobs.

5. After making the necessary settings, click [Print].

The document file is saved in the machine.

To print the document, perform the following steps.

To delete the document, see Job Type.

6. On the machine's control panel, press the [Printer] key to display the printer screen.

7. Press [Print Jobs].

A list of print files stored in the machine appears.

8. Press [Locked Print Job List].

A list of locked print files stored in the machine appears.

[User ID], [Date / Time] and [File Name] also appear.

9. Select the file you want to print by pressing it.

10. Press [Print].

The password screen appears.

11. Enter the password using the number keys, and then press [OK].

A confirmation screen appears.

A confirmation screen will appear if the password is not entered correctly. Press [Exit] to enter the
password again.

When multiple print files are selected, the machine prints only files that correspond to the entered
password. The number of files is displayed on the confirmation screen.

12. Press [Yes].

The locked file is printed.

• Pressing the [Clear/Stop] key after you press [Yes] to print cancels printing The file will remain in the
machine.

• To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started, the file is deleted.
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Deleting a Locked Print File

If a printed document is not as required, you can delete the Locked Print file.

1. On the machine's control panel, press the [Printer] key to display the printer screen.

2. Press [Print Jobs].

A list of print files stored in the machine appears.

3. Press [Locked Print Job List].

A list of locked print files stored in the machine appears.

4. Select the file you want to delete by pressing it.

To cancel a selection, press the highlighted job again.

Only one file can be selected at a time.

5. Press [Delete].

A password screen appears.

6. Enter the password using the number keys, and then press [OK].

A confirmation screen appears.

A confirmation screen will reappear if the password was entered incorrectly. Press [Exit] to enter the
password again.

When multiple files are selected, the machine deletes only files that correspond to the entered
password. The number of files to be deleted is displayed on the confirmation screen.

7. Press [Yes].

The selected file is deleted.

• Press [No] to cancel the delete request.

How to Use Hold Print

Follow the procedure below to print a document using the Hold Print function.

Windows 2000/XP/Vista, Windows Server 2003/2003 R2/2008

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. Select the printer, and then open the [Printing Preferences] dialog box.

3. In the [Job Type:] list, click [Hold Print].

4. Click the [Details...].
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5. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters. [File Name:] can also be set.

The user ID associates the user with his / her jobs.

6. Click [OK].

7. Click [OK] to close the printer properties dialog box.

If the application has a collate option, make sure it is not selected before sending a print job. The
printer driver automatically collates Hold Print files by default. If a collate option is selected from the
application's Print dialog box, there may be more prints than required.

8. Start the printing from the application's [Print] dialog box.

The document file is saved in the machine.

To print the document, perform the following steps.

To delete the document, see JobType.

9. On the machine's control panel, press the [Printer] key to display the printer screen.

10. Press [Print Jobs].

A list of print files stored in the machine appears.

11. Press [Hold Print Job List].

A list of hold print files stored in the machine appears.

[User ID], [Date / Time] and [File Name] also appear.

Depending on the security settings, certain print jobs may not be displayed.

12. Select the file you want to print by pressing it.

13. Press [Print].

A confirmation screen appears.

14. Press [Yes].

The hold print file is printed.

• Pressing the [Clear/Stop] key after you press [Yes] to print cancels printing The file will remain in the
machine.

• To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started, the file is deleted.

• When printing finishes, the stored file is deleted.

• If the application has a collate option, make sure it is not selected before sending a print job. The
printer driver automatically collates Hold Print files by default. If a collate option is selected from the
application's Print dialog box, there may be more prints than required.
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Mac OS/Mac OS X

1. From an application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. In the pop-up menu, click [Job Log].

3. On the [Job Type:] pop-up menu, click [Hold Print].

4. In the [User ID:] box, enter the user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters. [File Name:] can also be set.

The user ID associates the user with his / her jobs.

5. After making the necessary settings, click [Print].

The document file is saved in the machine.

To print the document, perform the following steps.

To delete the docuemt, see Job Type.

6. On the machine's control panel, press the [Printer] key to display the printer screen.

7. Press [Print Jobs].

A list of print files stored in the machine appears.

8. Press [Hold Print Job List].

A list of hold print files stored in the machine appears.

[User ID], [Date / Time] and [File Name] also appear.

Depending on the security settings, certain print jobs may not be displayed.

9. Select the file you want to print by pressing it.

10. Press [Print].

A confirmation screen appears.

11. Press [Yes].

The hold print file is printed.

• Pressing the [Clear/Stop] key after you press [Yes] to print cancels printing The file will remain in the
machine.

• To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started, the file is deleted.

• When printing is completed, the stored file is deleted.

Deleting a Hold Print File

If a printed document is not as required, you can delete the Hold Print file.

1. On the machine's control panel, press the [Printer] key to display the printer screen.
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2. Press [Print Jobs].

A list of the print files stored in the machine appears.

3. Press [Hold Print Job List].

A list of Hold Print files stored in the machine appears.

Depending on the security settings, certain print jobs may not be displayed.

4. Select the file you want to delete by pressing it.

5. Press [Delete].

A confirmation screen appears.

6. Press [Yes].

The selected file is deleted.

• Press [No] to cancel the delete request.

How to Use Stored Print/Store and Normal Print

Follow the procedure below to print a document using the Stored Print function.

Windows 2000/XP/Vista, Windows Server 2003/2003 R2/2008

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. Select the printer, and then open the [Printing Preferences] dialog box.

3. In the [Job Type:] list, click [Stored Print] or [Store and Normal Print].

• [Stored Print]

Stores the file in the printer and print it later using the control panel.

• [Store and Normal Print]

Prints the file at once and also stores the file in the printer.

4. Click the [Details...].

5. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters, and then enter a 4-8 digit password in the [Password:] box. [File Name:] can
also be set.

The user ID associates the user with his / her job.

You can assign a password to a saved document, but password assignment is not mandatory.

The same password must be entered when printing or deleting.

6. Click [OK].
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7. Click [OK] to close the printer properties dialog box.

If the application has a collate option, make sure it is not selected before sending a print job. The
printer driver automatically collates Stored Print files by default. If a collate option is selected from the
application's Print dialog box, there may be more prints than required.

8. Start the printing from the application's [Print] dialog box.

The document file is saved in the machine.

To print the document, perform the following steps.

To delete the document, see Job Type.

9. On the machine's control panel, press the [Printer] key to display the printer screen.

10. Press [Print Jobs].

A list of print files stored in the machine appears.

11. Press [Stored Print Job List].

A list of stored print files stored in the machine appears.

[User ID], [Date / Time] and [File Name] also appear.

Depending on the security settings, certain print jobs may not be displayed.

12. Select the file you want to print by pressing it.

13. Press [Print].

A confirmation screen appears.

If you have already set a password, proceed to the following step.

14. Enter a password using the number keys on the password screen, and then press [OK].

A confirmation screen will appear if the password is not entered correctly. Press [OK] to enter the
password again.

If you have not set the password, proceed to the following step.

15. Press [Yes].

The stored file is printed.

• Pressing the [Clear/Stop] key after you press [Yes] to print cancels printing The file will remain in the
machine.

• To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started, the file is deleted.

• Stored Print files sent to the machine are not deleted unless you delete them in the machine or select
[Auto Delete Stored Print Jobs] (see “System”, Printer Reference). For details, see Job Type.

• If the application has a collate option, make sure it is not selected before sending a print job. The
printer driver automatically collate Stored Print files by default. If a collate option is selected from the
application's Print dialog box, there may be more prints than required.
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Mac OS/Mac OS X

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. In the pop-up menu, click [Job Log].

3. On the [Job Type:] pop-up menu, click [Stored Print] or [Store and Print].

• [Stored Print]

Stores the file in the printer and print it later using the control panel.

• [Store and Print]

Prints the file at once and also stores the file in the printer.

4. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters, and then enter a 4-8 digit password in the [Password:] box. [File Name:] can
also be set.

The user ID associates the user with his / her jobs.

You can assign a password to a saved document, but password assignment is not mandatory.

The password must be entered when printing or deleting.

5. After making the necessary settings, click [Print].

The document file is saved in the machine.

To print the document, perform the following steps.

To delete the document, see Job Type.

6. On the machine's control panel, press the [Printer] key to display the printer screen.

7. Press [Print Jobs].

8. Press [Stored Print Job List].

A list of stored print files stored in the machine appears.

[User ID], [Date / Time] and [File Name] also appear.

Depending on the security settings, certain print jobs may not be displayed.

9. Select the file you want to print by pressing it.

10. Press [Print].

A confirmation screen appears.

If you have already set a password, proceed to the following step.

11. Enter a password using the number keys on the password screen, and then press [OK].

A confirmation screen will appear if the password is not entered correctly. Press [OK] to enter the
password again.

If you have not set the password, proceed to the following step.
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12. Press [Yes].

The stored file is printed.

• Pressing the [Clear/Stop] key after you press [Yes] to print cancels printing The file will remain in the
machine..

• To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started, the file is deleted.

• Stored Print files sent to the machine is not deleted unless you delete them in the machine or select
[Auto Delete Stored Print Jobs] (see “System”, Printer Reference). For details, see Job Type.

Deleting a Stored Print File

If a printed document is not as required, you can delete the Stored Print file.

1. On the machine's control panel, press the [Printer] key to display the printer screen.

2. Press [Print Jobs].

A list of print files stored in the machine appears.

3. Press [Stored Print Job List].

A list of stored print files stored in the machine appears.

4. Select the file you want to delete by pressing it.

To cancel a selection, press the highlighted job again.

5. Press [Delete].

A confirmation screen appears.

6. Press [Yes].

The selected file is deleted.

• Press [No] to cancel the delete request.

• If you have already set a password in the printer driver, enter it to delete.

How to Use Send to Document Server

Follow the procedure below to print a document using the Document Server function.

Windows 2000/XP/Vista, Windows Server 2003/2003 R2/2008

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. Select the printer, and then open the [Printing Preferences] dialog box.
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3. In the [Job Type:] list, click [Send to Document Server].

4. Click the [Details...].

5. In the [User ID:] box, enter the user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters. A file name and password can also be entered arbitrarily.

The user ID associates the user with his / her job.

You can assign a password to a saved document, but password assignment is not mandatory.

The same password must be entered when printing or deleting.

6. Click [OK].

7. Click [OK] to close the [Job Type Details] dialog box.

8. Start the printing from the application's [Print] dialog box.

• If you are using Mac OS X 10.1.x, this function cannot be used.

If you are using Mac OS X 10.2.x or higher, the Job Type function can be used.

Mac OS X

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. In the pop-up menu, click [Job Log].

3. On the [Job Type:] pop-up menu, click [Document Server].

4. In the [User ID:] box, enter the user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters. A file name and password can also be entered arbitrarily.

The user ID associates the user with his / her job.

You can assign a password to a saved document, but password assignment is not mandatory.

The same password must be entered when printing or deleting.

5. Start the printing from the application's [Print] dialog box.

User Code

Use this to set a user code for print logging.

Enter a user code using up to eight digits. A user code identifies a group of users and allows you to check
the number of sheets printed under each code with SmartDeviceMonitor for Admin.

The following table shows the tabs or menus where you can select this function.
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Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

Enter a user code in the [User Code:] box on the
[Job Setup] menu in the [Printing Preferences]
dialog box.

Mac OS
Select the [Enable User Code] check box, and then
enter a user code in the [User Code] box on [Job
Log] in the print dialog box.

Mac OS X
Select the [Enable User Code] check box, and then
enter a user code in the [User Code] box on [Job
Log] in the print dialog box.

• For details about using SmartDeviceMonitor for Admin, see Help.

Paper Size

Use this to select the size of paper you want to use.

The following table shows the tabs or menus where you can select this function.

Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

[Paper Size:] is displayed on the [Basic] menu in
the [Printing Preferences] dialog box.

Mac OS
[Paper:] on the [Page Attributes] tab in the Page
Setup dialog box.

Mac OS X [Paper Size:] in the Page Setup dialog box.

• For details about the paper sizes supported by this machine, see General Setting Guide.

Fit to Paper

When the size of the document and paper size differ, set whether or not to print according to paper size.

Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

[Fit to Paper] is displayed on the [Paper] menu in
the [Printing Preferences] dialog box.

Mac OS
[Fit to Paper] on [Printer Specific Options] in the
print dialog box.
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Mac OS X
[Fit to Paper] on the [Features x] tab on [Printer
Features] in the print dialog box.

[Prompt User]

Print is performed with the size of document to be printed unchanged.

[Nearest Size and Scale]

If the paper size is smaller than the selected paper size, the driver reduces the print size.

If the paper size is larger than the size of document to be printed, print is not to fit the paper size.

[Nearest Size and Crop]

When the paper size is smaller than the size of document to be printed, print is adjusted to meet the
paper size.

Input Tray

Use this to select the paper sources.

The following table shows the tabs or menus where you can select this function.

Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

[Input Tray:] is displayed on the [Paper] menu in the
[Printing Preferences] dialog box.

Mac OS
[Paper Source] on [General] in the print dialog
box.

Mac OS X [Paper Feed] in the print dialog box.

• For details about the paper sources, see Printer Reference.

Resolution

Use this to set the resolution types.

The following table shows the tabs or menus where you can select this function.

Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

[Resolutions:] is displayed on the [Print Quality]
menu in the [Printing Preferences] dialog box.

Mac OS
[Resolution] on [Printer Specific Options] in the print
dialog box.
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Mac OS X
[Resolution] on the [Features x] tab on [Printer
Features] in the print dialog box.

• For more information about the resolution types, see Printer Reference.

Rotate by 180 degrees

Use this to rotate the print image by 180 degrees.

The following table shows where you can select this function.

Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

Check the [Rotate by 180 degrees:] check box on
the [Basic] menu in the [Printing Preferences] dialog
box.

Mac OS
[Rotate by 180 degrees] in [Printer Specific
Options] in the print dialog box.

Mac OS X
[Rotate by 180 degrees] on the [Features x] tab in
[Printer Features] in the print dialog box.

Orientation Override

Use this to set the paper orientation.

The following table shows the tabs or menus where you can select this function.

Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

[Orientation Override:] is displayed on the
[Finishing] menu in the [Printing Preferences] dialog
box.

Mac OS
[Orientation Override] on [Printer Specific
Options] in the print dialog box.

Mac OS X
[Orientation Override] on the [Features x] tab on
[Printer Features] in the print dialog box.

You can select the following items:

• [Off]

• [Landscape]

• [Portrait]
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Print Mode / Toner Saving

Use this function to reduce the amount of toner used when printing.

The following table shows the tabs or menus where you can select this function.

Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

[Print Mode] is displayed on the [Print Quality]
menu in the [Printing Preferences] dialog box.

Mac OS
[Print Mode:] on [Printer Specific Options] in the
print dialog box.

Mac OS X
[Print Mode:] on the [Features x] tab on [Printer
Features] in the print dialog box.

You can select the following items:

Off

Disables print mode.

Toner Saving

Reduces the amount of toner used when printing.

Duplex Printing

Use this function to select duplex printing.

• To use this function, the optional duplex unit must be installed on the machine.

The following table shows the tabs or menus where you can select this function.

Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

[Duplex] is displayed on the [Edit] menu in the
[Printing Preferences] dialog box.

Mac OS
[Print on Both Sides] on [Layout] in the print dialog
box.

Mac OS X

• 10.3 or higher

The [Two Sided Printing] check box on
[Layout] in the print dialog box.

• Other Mac OS X

The [Print on both Sides] check box on
[Duplex] in the print dialog box.
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The following items may vary depending on the operating system you are using.

Windows 2000/XP/Vista, Windows Server 2003/2003 R2/2008, Mac OS

Off

Disables Duplex Printing.

Long Edge

Prints output so that you can open it to the long edge when bound along the long edge.

Short Edge

Prints output so that you can open it to the short edge when bound along the short edge.

• If you are using a Mac OS, click to select the button that means “Flip on Long Edge” or “Flip on Short
Edge”.

Mac OS X

The following functions are selectable under Mac OS X 10.3 or higher (for Mac OS X 10.2 or earlier, see
Windows 2000/XP/Vista, Windows Server2003/2003 R2/2008, Mac OS in Duplex Printing)

Off

Disables Duplex Printing.

Long-Edge Binding

Prints output so that you can open it to the long edge when bound along the long edge.

Short-Edge Binding

Prints output so that you can open it to the short edge when bound along the short edge.

Collate

Use this function to enable collation. With this feature, the machine can efficiently print collated sets of
multiple-page documents.

• If you are using Mac OS or Mac OS X, make sure that the following check boxes have not been
selected.

• Mac OS

The [Collate] check box in the print dialog box.

• Mac OS X

The [Collate] check box on [Copies & Pages] in the printer dialog box.
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The following table shows the tabs or menus where you can select this function.

Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

Set the number of copies to two or more on the
[Basic] menu, and then select [On] or [Off] on the
[Collate:] list on the [Finishing] menu in the [Printing
Preferences] dialog box.

Mac OS
[Collate:] on [Printer Specific Options] in the print
dialog box.

Mac OS X
[Collate:] on the [Feature 1] tab on [Printer Feature]
in the printer dialog box.

Paper Type

Use this to select the paper type.

The following table shows the tabs or menus where you can select this function.

Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

[Paper Type] is displayed on the [Paper] menu in
the [Printing Preferences] dialog box.

Mac OS
[Paper Type] on [Printer Specific Options] in the
print dialog box.

Mac OS X
[Paper Type] on the [Features x] tab on [Printer
Features] in the print dialog box.

• For details about the media type supported by this machine, see General Setting Guide.

Destination

Use this to select the destination tray.

The following table shows where you can select this function.

Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

[Destination] is displayed on the [Finishing] menu
in the [Printing Preferences] dialog box.

Mac OS
[Destination] in [Printer Specific Options] in the print
dialog box.
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Mac OS X
[Destination] on the [Features x] tab in [Printer
Features] in the print dialog box.

• For details about the destination tray supported by this machine, see General Setting Guide.

Staple

Use this function to staple sheets of printed paper together.

• When stapling, use the finisher option. See General Setting Guide or Printer Reference.

The following table shows where you can select this function.

Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

[Staple:] is displayed on the [Finishing] menu in the
[Printing Preferences] dialog box.

Mac OS
[Staple:] in [Printer Specific Options] in the print
dialog box.

Mac OS X
[Staple:] on the [Features x] tab in [Printer Features]
in the print dialog box.

• The stapling location might differ depending on the orientation of the machine set in the printer and
the orientation of the data to be printed. For details, see Printer Reference.

Punch

Use this function to punch holes in the printed documents.

• When punching holes, use the finisher option. See Printer Reference.

The following table shows where you can select this function.

Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

[Punch] is displayed on the [Finishing] menu in the
[Printing Preferences] dialog box.

Mac OS
[Punch:] in [Printer Specific Options] in the print
dialog box.
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Mac OS X
[Punch:] on the [Features x] tab in [Printer Features]
in the print dialog box.

• Punch positions and the number of punch holes that are available will change depending on the type
of finisher, the original's orientation, and the printing paper size and orientation. For details, see Printer
Reference.

Watermark

Set the Watermark function.

Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

[Watermark] is displayed on the [Effects] menu in
the [Printing Preferences] dialog box.

Mac OS X
[Watermark] on the [Features x] tab in the Print
dialog box.

• When using this function under Mac OS, see the printer driver Help. The following explains the
procedure for Windows 2000/XP/Vista, and Windows Server 2003/2003 R2/2008.

Watermark Text

Select the Watermark Text type.

Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

[Watermark Text] is displayed on the [Effects] menu
in the [Printing Preferences] dialog box.

Mac OS X
[Watermark Text] on the [Features x] tab in the Print
dialog box.

• When using this function under Mac OS, see the printer driver Help. The following explains the
procedure for Windows 2000/XP/Vista, and Windows Server 2003/2003 R2/2008.

Watermark Font

Select the Watermark Font type.
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Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

[Watermark Font] is displayed on the [Effects] menu
in the [Printing Preferences] dialog box.

Mac OS X
[Watermark Font] on the [Features x] tab in the Print
dialog box.

• When using this function under Mac OS, see the printer driver Help. The following explains the
procedure for Windows 2000 / XP / Vista, and Windows Server 2003 / 2003 R2 / 2008.

Watermark Size

Select the Watermark Size.

Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

[Watermark Size] is displayed on the [Effects]
menu in the [Printing Preferences] dialog box.

Mac OS X
[Watermark Size] on the [Features x] tab in the Print
dialog box.

• When using this function under Mac OS, see the printer driver Help. The following explains the
procedure for Windows 2000/XP/Vista, and Windows Server 2003/2003 R2/2008.

Watermark Angle

Select the Watermark Angle.

Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

[Watermark Angle] is displayed on the [Effects]
menu in the [Printing Preferences] dialog box.

Mac OS X
[Watermark Angle] on the [Features x] tab in the
Print dialog box.

• When using this function under Mac OS, see the printer driver Help. The following explains the
procedure for Windows 2000/XP/Vista, and Windows Server 2003/2003 R2/2008.
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Watermark Style

Select the Watermark Style.

Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

[Watermark Style] is displayed on the [Effects]
menu in the [Printing Preferences] dialog box.

Mac OS X
[Watermark Style] on the [Features x] tab in the
Print dialog box.

• When using this function under Mac OS, see the printer driver Help. The following explains the
procedure for Windows 2000/XP/Vista, and Windows Server2003/2003 R2/2008.

Dithering

Use this to set the Image Rendering mode.

The following table shows the tabs or menus where you can select this function.

Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

[Dithering] is displayed on the [Print Quality] menu
in the [Printing Preferences] dialog box.

Mac OS
[Dithering:] on [Printer Specific Options] in the print
dialog box.

Mac OS X
[Dithering:] on the [Features x] tab on [Printer
Features] in the print dialog box.

You can select the following items:

Auto

Use this setting to configure the best dithering method automatically depending on the appearance
of the document to be printed.

Photographic

Performs dithering using an appropriate pattern for photographs.

Text

Performs dithering using an appropriate pattern for text.

User Setting

Use this setting to print images set in half tone in your application.

Printing a Document

91

3



Image Smoothing

Use this to select the Image Smoothing type.

The following table shows the tabs or menus where you can select this function.

Windows 2000/XP/Vista, Windows Server
2003/2003 R2/2008

[Image Smoothing] is displayed on the [Print
Quality] menu in the [Printing Preferences] dialog
box.

Mac OS
[Image Smoothing:] on [Printer Specific Options] in
the print dialog box.

Mac OS X
[Image Smoothing:] on the [Features x] tab on
[Printer Features] in the print dialog box.

Off

Disables Image Smoothing.

On

Performs Image Smoothing unconditionally.

Auto

Performs Image Smoothing automatically for images that have a resolution less than 25% of supported
printer resolution.

Less than 90 ppi - Less than 300 ppi

Performs Image Smoothing only when the image has an image resolution (pixels per inch) less than
the respective value you have selected in the list.

• When [Auto] is selected, data processing may take a long time.

• When Image Smoothing is used for a mask image, this function may have an undesired effect on the
print result.
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4. Printer Utility for Mac

Installing Printer Utility for Mac
Follow these steps to install Printer Utility for Mac on the machine.

• If a Macintosh and printer are connected by USB, you cannot use Printer Utility for Mac.

1. Start the Mac OS.

2. Insert the CD-ROM into the CD-ROM drive.

The CD-ROM icon appears.

3. Double-click the CD-ROM icon.

The contents of the CD-ROM appear.

4. Double-click the [Mac OS] folder.

Under Mac OS X, double-click the [Mac OS X] folder.

5. Double-click the [PS Utility] folder on the CD-ROM, and then drag the [Printer Utility for
Mac] file, and then drop it into the Macintosh hard disk.

6. Drag the CD-ROM icon and drop it into [Trash] to eject the CD-ROM.

Printer Utility for Mac is installed.

• Printer Utility for Mac is included on the driver CD-ROM.

• Printer Utility for Mac requires Mac OS 8.1 or higher. (Mac OS X Classic environment is supported.)

• Printer Utility for Mac cannot use Mac OS X (native mode).
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Starting Printer Utility for Mac
The following instructions describe how to start Printer Utility for Mac.

Mac OS

• Before starting Printer Utility for Mac, make sure the printer is selected in [Chooser] on the Apple
menu.

1. Double-click the Printer Utility for Mac icon.

The [Printer Utility for Mac] dialog box appears.

2. Click [OK].

Printer Utility for Mac will take a few seconds to start.

Mac OS X

1. Double-click the Printer Utility for Mac icon.

The [Printer Utility for Mac] dialog box appears.

2. Click [OK].

3. In the [Available Printers:] box, select the printer you want to use.

If you change zones, select a name from [Available Network Zones:].

Click [Choose Printer...] on the Printer Utility for Mac menu if you want to change the printer.

4. Select the printer you want to use.

Printer Utility for Mac will take a few seconds to start.

5. Click [Choose].
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Printer Utility for Mac Functions
Printer Utility for Mac functions are described below.

File menu

• [Download PS Fonts...]

Download fonts (PostScript Type 1) to the printer. See Downloading PS Fonts.

• [Display Printer's Fonts...]

Display and delete the fonts in printer memory and the printer's hard disk drive.

See Displaying Printer's Fonts.

• [Initialize Printer's Disk...]

Initialize the printer's hard disk drive. See Initializing the Printer Disk.

• [Page Setup...]

Set up the paper size to print “Printer Font Catalog” and “Printer Font Sample”.

See Page Setup.

• [Print Fonts Catalog...]

Print the names of available fonts. See Printing Fonts Catalog.

• [Print Fonts Sample...]

Print a sample of fonts. See Printing Fonts Sample.

• [Rename Printer...]

Change the printer's name when viewed via AppleTalk. See Renaming the Printer.

• [Restart Printer]

Restart the printer. See Restarting the Printer.

Utility menu

• [Download PostScript File...]

Download a PostScript file. See Downloading PostScript Files.

• [Select Zone...]

Change the zone to which the printer belongs to via AppleTalk. See Selecting the Zone.

• [Display Printer Status...]

Display the status of the printer. See Displaying the Printer Status.

• [Launch Dialogue Console...]

Create and edit a PostScript file, and then download it to the printer. See Launching the Dialogue
Console.

Printer Utility for Mac Functions

95

4



Downloading PS Fonts

You can download the PS fonts to the printer's memory or hard disk drive.

• The following procedures to download the fonts assume that you are a system administrator. If you
are not, be sure to consult your system administrator.

• If the printer restarts, all the printer settings return to their defaults.

• Confirm that a Mac OS and the printer are connected with AppleTalk.

• During the download, do not turn off the power switch, operate the panel or open or close the cover.

1. Select [Download PS Fonts...] on the [File] menu.

2. Click [Add to list].

The dialog box to select fonts appears.

3. Click to select the desired font files, and then click [Open].

The list of selectable font names appears.

4. After adding all the fonts you want to download, click [OK].

The dialog box of selected fonts to download appears.

5. Click [Download].

The fonts begin to download, and the download status is shown.

6. When the completion message appears, click [OK].

7. Click [Cancel].

• Some fonts cannot be downloaded.

• Before downloading, read the documentation about the fonts you want to use.

Displaying Printer's Fonts

You can display the available fonts currently downloaded to the printer. Fonts in the printer's memory and
hard disk drive can be displayed.

1. Select [Display Printer's Fonts...] on the [File] menu.

A dialog box appears.

2. Select [Printer's memory] or [Printer's disk].

3. Click [OK].
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• The fonts displayed in italics are the default fonts.

Deleting Fonts

You can delete fonts from the printer's memory or hard disk drive.

• You cannot delete the fonts displayed in italic.

1. Select [Display Printer's fonts] on the [File] menu.

A dialog box appears.

2. Select [Printer's memory] or [Printer's disk].

3. Select the fonts you want to delete.

4. Click [Delete].

A confirmation message appears.

5. Confirm the fonts you want to delete and the printer name from which you want to delete
the fonts.

6. Click [Continue], and then click [OK].

7. Click [OK].

Initializing the Printer Disk

When initializing the printer's hard disk drive, all the fonts downloaded to the printer's hard disk drive are
deleted. Before initializing, be sure to check the fonts on the hard disk drive.

• When initializing the printer's hard disk drive from the operation panel, all of the data on the printer's
hard disk drive is deleted. Before initializing, be sure to check the data on the hard disk drive.

• Do not turn off the power switch until initializing is completed, otherwise the hard disk drive might be
damaged.

1. Select [Initialize Printer's Disk...] on the [File] menu.

The confirmation message appears.

To cancel initialization, click [Cancel].

2. Click [Execute].

Initializing starts.

3. When the completion message appears, click [OK].
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Page Setup

You can set the paper size on which to print “Print Fonts Catalogue” and “Prints Fonts Sample”.

1. Select [Page Setup...] on the [File] menu.

2. Choose the paper size.

Printing Fonts Catalog

Print the names of fonts available on the printer.

1. Select [Print Fonts Catalogue] on the [File] menu.

2. Click [Print].

• The paper selected under [Page Setup] is used.

Printing Fonts Sample

You can print samples of fonts downloaded to the hard disk drive or memory.

1. Select [Print Fonts Sample...] on the [File] menu.

2. Click [Print].

• Print by using the paper selected on [Page Setup].

Renaming the Printer

You can change the printer name displayed under AppleTalk. If you connect several printers on the network,
assign different names so you can identify them. If several printers have the same name, a digit appears
next to the printer name in [Chooser].

• You can enter up to 31 digits and letters.

• Do not use symbols, for example “*”, “:”, “=”, “@”, “~”.

Mac OS

1. On the [File] menu, click [Rename Printer...].

2. In the [New Name:] filed enter a new name.
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3. Click [Rename].

The printer name is changed.

4. Click [OK].

5. On the Apple menu, click [Chooser].

6. Click the [AdobePS] icon.

7. Select the printer whose name you changed, and then close the [Chooser] dialog box.

If there are several AppleTalk zones, select the zone the machine belongs to.

Mac OS X

1. On the [File] menu, click [Rename Printer...].

2. In the [New Name:] filed enter a new name.

3. Click [Rename].

The printer name is changed.

4. Click [OK].

5. On the Printer Utility for Mac menu, click [Choose Printer...].

6. In the [Available Network Zones:] list, select the zone for the Macintosh in use.

7. In the [Available Printers:] list, select the printer whose name you changed, and then click
[Choose].

Restarting the Printer

You can restart the printer.

1. Select [Restart Printer] on the [File] menu.

2. Confirm the message that appears on the screen, and then click [Restart].

The printer restarts.

The fonts that you downloaded in the printer's memory will be deleted.

If the printer restarts, all the printer settings return to their defaults.

Downloading PostScript Files

You can download a Postscript file to the printer.

1. Select [Download PostScript File...] on the [Utility] menu.

2. Select the file name to download and click the file name, and then click [Open].
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3. Type the log file name, and then click [Save...].

The selected file is downloaded.

Errors are recorded in the log file.

Selecting the Zone

You can change the zone to which the printer belongs under AppleTalk.

• Confirm that a Macintosh and printer are connected with AppleTalk.

Mac OS

1. On the [Utility] menu, click [Select Zone...].

The zone to which the printer belongs and the available zone list appear.

2. Select the zone in which you want to locate the printer, and then click [Change].

A confirmation message appears.

3. Click [Continue].

A confirmation message appears.

4. Click [OK].

5. On the Apple menu, click [Chooser].

6. Click the [AdobePS] icon.

7. In the [AppleTalk zone:] list, select the zone you changed.

8. In the [Select a PostScript Printer:] list, select the printer you want to use.

9. Close the [Chooser] dialog box.

Mac OS X

1. On the [Utility] menu, click [Select Zone...].

The zone to which the printer belongs and the available zone list appear.

2. Select the zone which you want to locate the printer in, and then click [Change].

A confirmation message appears.

3. Click [Continue].

A confirmation message appears.

4. Click [OK].

5. On the [Printer Utility for Mac] menu, click [Choose Printer...].

6. In the [Available Network Zones:] list, select the zone you changed.
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7. In the [Available Printers:] list, select the model of printer in use, and then click [Choose].

Displaying the Printer Status

You can display and confirm the current status of the printer.

1. Select [Display Printer Status...] on the [Utility] menu.

The current status of the printer appears.

2. Confirm the current status of the printer.

You can confirm the memory capacity, the VM (Virtual Memory) space, the hard disk drive status and
available space on the hard disk drive. You can also confirm the zone to which the printer belongs
to.

3. Click [OK].

Launching the Dialogue Console

You can create and edit a PostScript file for printing, and then download it to the printer.

• “Launch Dialogue Console” is recommended for users with an understanding of PostScript.

• Do not download any file other than PostScript files to the printer.

• “Launch Dialogue Console” must be used at your own responsibility.

1. Select [Launch Dialogue Console...] on the [Utility] menu.

Open the editing screen. The Dialogue Console menu bar appears.

2. Type the PostScript command in the editor screen.

To edit a PostScript file, select [Open] on the [File] menu to open it.

You can search or replace a character string by using the [Search] menu.

3. After editing the PostScript file, select [Download Top Window] on [Console] menu to start
printing.

The PostScript file is sent to the printer.

The [Reply from Printer] box opens, depending on the PostScript file you sent.

4. Select [Return To Main Menu] on the [Console] menu to close the PostScript file.
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Trademarks

Microsoft®, Windows®, Windows Server® and Windows Vista® are registered trademarks of Microsoft Corporation in 

the United States and/or other countries.

Adobe, Acrobat, Adobe Type Manager, PageMaker, PostScript are either registered trademarks or trademarks of 

Adobe Systems Incorporated in the United States and/or other countries.

Apple, AppleTalk, Bonjour, EtherTalk, Macintosh, Mac OS, and TrueType are trademarks of Apple Inc., registered in 

the U.S. and other countries.

The Bluetooth® word mark and logos are registered trademarks owned by Bluetooth SIG, Inc. and any use of such 

marks by Ricoh Company, Ltd is under license.

Other product names used herein are for identification purposes only and might be trademarks of their respective 

companies. We disclaim any and all rights in those marks.

The proper names of the Windows operating systems are as follows:

* The product names of Windows 2000 are as follows:

Microsoft® Windows® 2000 Professional

Microsoft® Windows® 2000 Server

Microsoft® Windows® 2000 Advanced Server

* The product names of Windows XP are as follows:

Microsoft® Windows® XP Professional

Microsoft® Windows® XP Home Edition

Microsoft® Windows® XP Media Center Edition

Microsoft® Windows® XP Tablet PC Edition

* The product names of Windows Vista are as follows:

Microsoft® Windows Vista® Ultimate

Microsoft® Windows Vista® Business

Microsoft® Windows Vista® Home Premium

Microsoft® Windows Vista® Home Basic

Microsoft® Windows Vista® Enterprise

* The product names of Windows Server 2003 are as follows:

Microsoft® Windows Server® 2003 Standard Edition

Microsoft® Windows Server® 2003 Enterprise Edition

Microsoft® Windows Server® 2003 Web Edition

Microsoft® Windows Server® 2003 Datacenter Edition

* The product names of Windows Server 2003 R2 are as follows:

Microsoft® Windows Server® 2003 R2 Standard Edition

Microsoft® Windows Server® 2003 R2 Enterprise Edition

Microsoft® Windows Server® 2003 R2 Datacenter Edition

* The product names of Windows Server 2008 are as follows:

Microsoft® Windows Server® 2008 Standard

Microsoft® Windows Server® 2008 Enterprise

Microsoft® Windows Server® 2008 Datacenter
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